
How to create my own eBook

Introduction
In spring 2012 some members of the working group "Media" of the Center for Continuing
Education of the University of Ulm (ZAWiW) had the idea to deal with eBooks. Supervised
by Manfred Helzle they scrutinized privately and on several meetings at the PC-Pool of
ZAWiW at Ulm University all  available information on the internet, in magazines and in
other  relevant  literature to  get  a  clear  idea of  the  current  state  of  debate  on topic  of
eBooks.
At these occasions there were further more various tools discussed and tested by a small
circle of the whole group, and finally there was written a working paper. After that the other
members of the AK Media were made familiar with the topic and the tools in a workshop
on 06.12.2012 at Villa Eberhardt in Ulm.
In June 2012 the group decided to present their project at the international symposium of
the European Grundtvig Learning Partnership "Seniors Knowledge Society" in Prague on
which other  european participating  countries were encouraged to take actively  part  in.
The issue was deepened at two more symposia in November 2012 in Rotterdam (the
Netherlands) and in March 2013 in Reggio Emilia (Italy).
The aim of  the project  is to  produce an eBook that  explains  to  seniors how to make
eBooks (an eBook tutorial for senior fellows).

Until now those are the following results:

In addition to the traditional print media like documents, books or magazines, etc. we use
two electronic formats to read them on the screen. There are PDF and eBook formats.

A PDF-document has  a  fixed  layout  (page  formatting,  header  and  footer  etc.)  and
an unalterable appearance (for instance, font style and size). 

The eBook-format,  however,  is completely flexible and can be optimally adjusted and
directly changed for individual reader’s needs by the readers themselves.
eBooks are, first digital documents, which can be read like books on an electronic device,
such  as  tablet-PCs  or  iPads,  but  further  more  they  can  offer  a  lot  of  additional
opportunities.

There are (mostly older publications) eBooks for free (for instance at www.gutenberg.org)
and there is current literature available for usually lower prices than the paper editions.

The main differences between an eBook and a paper-book are:
   - Customized font size and style
   - Multimedia in form of photos / photo galleries, video, 3D-animation, audio
   - intuitive touch-handling
   - Interactive communication (question and answer)
   - linked directly to the web or to other pages or documents on the internet
   - bookmarks and notes management

eBooks can, like PDFs, be created by a respective program:
 - Calibre (free open source) for Windows, Linux, OS X 
 - IBooks Author (free Apple) for OS X
 - the addon Writer2ePub for Open / Libre-Office offers ePub export
 - Pages (Apple) offers direct ePub export
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eBook - files can be represented on three different groups of devices: 
eBook reader: mobile devise
Tablet: mobile device
Personal Computer: noteBook or desktop

There are eBook readers from all well known book stores such as
-  Amazon (Kindle -Family),
-  Thalia  (Tolino - Family) 
- and others which substantially can acquire  present eBooks and mobile devices, for

example 
-   Apple  (iPad, iPhone, iPod with IOS)
-   or Google partners (Android devices), and more recently also by Microsoft (Surface

  Windows)  8,  which  offer  many  other  functions  as  well  such  as  email,
  internet, Office applications, calendar, contacts, photo and video camera, Dropbox,
  Skype, FaceBook and so on and countless so-called apps, that is, applications, little 
  software programs for mobile devices of which the bandwidth is very high.  They
  range  from  the  simplest  tools  and  fun  applications  with  only  one  function  to
  program packages with extensive functionality.

  The  following  chapters  will  describe  in  detail  the  tools,  applications  and how
  to create an eBook.

Rolf-Peter Koenig, 20130320
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What is an eBook?
An eBook or electronic book is a representation of a book text on a screen of an electronic
device, an eBook reader. This instrument is able to store thousands of books. Pages are
turned with a fingertip. A large range of navigation is available to select pages, chapters,
titles. Online you can use hyperlinks and go to book stores to purchase new books, loaded
within a few minutes. Payment is made by your personal account. No paper is needed
which preserves the nature. eBooks are cheaper than printed books on paper. A lot of
older books are even free of charge. 
The eBook reader device has a special e-ink display design for comfortably reading. The
type size and fonts can be changed and adapted to individual needs. The sections in the
book are not indicated by page numbers but by per cent of the text.
eBooks  can  be  read  also  on  personal  computers  by  downloaded  eBook  reading
applications.
 
How to produce an eBook? 
The original text in PDF format has to be converted and exported into a special program,
for instance Libre Office open source with the downloaded extension Writer2ePub. Here
the text is transformed in “standard”. The cover shall get a picture, the Meta dates are to
be filled in and the titles, which will produce the index, are determined. Now the created
eBook document can be exported to the eBook reader. You can watch the eBook on your
computer with Calibre preview or FireFoxEPUBReader.

Gitti Nguyen-Duong, Christa Gloeggler, 20130123
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For seniors we have listed some advantages and some disadvantages of eBooks in
comparison to paper books:

An eBook reader or tablet has the size and the weight of a small thin paperback.

On such a device you can download as many books as you like. This is useful especially
when you travel a lot, since it saves weight and space.

Many eBooks are free of charge. Newly edited books are cheaper when you buy them in
the download version and are available in different languages.

You  can  customize  the  appearance  to  your  personal  reading  preferences:  Modify  the
brightness of the screen, the font size and style and layout. Some devices are even able to
read  text  out  loud.  This  might  be  very  important  when  your  eyesight  is  beginning  to
decrease.

There  is  the  option  of  implementing  bookmarks,  remarks  and  additional  links.  The
automatic  page  break  enables  you  to  read  without  any  disturbance  and  with  entire
concentration on the text.

More and more newspapers and magazines offer a download version in addition to their
paper editions. Most of them are available at a low price when you have a subscription of
the paper version. The electronic version is often free of advertisements. And moreover
you have some videos to show you events that you are interested in.

The  eBook  reader  or  tablet  replaces  heavy  books,  unwieldy  newspapers,  magazines
crowded with advertisements, expensive textbooks. you have access to archives, libraries
and many encyclopedia. 

You can order facsimiles online and thus you have access to old documents and books
that cannot be shown otherwise. 

Tools:
Character font and size are adaptable as well as pictures according to your eyesight. Even
you can have the text read aloud to you. In the offline modus the downloaded books are
always available.

You can search for persons, terms and passages, for instance of poems. You can insert
links to other documents and terms. You can bookmark a passage, add notes and create
and administer an index. The automatic page break adapts all your bookmarks, notes and
indexes. 

Create your own eBook and send copies of it to your friends! You do not have to look for
an editor; you do not have to pay the print costs...

A summary of the advantages:

Everything is at your hand, whether you want to read or to write, whether you are looking
for something or creating something, you do not need paper, pencil, neither encyclopedia
nor language book...
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Disadvantages:

You need an eBook-reader, a tablet or adds-on in Firefox, or software on your noteBook
like calibre.

The  rechargeable  batteries  in  the  tablets  are  mostly  not  replaceable.  You  have  to
discharge your device (save your files) when the battery is exhausted. By now it is not
known when this will happen....  

You need WLAN or a wireless internet access in order to be able to download the files on
your device - in some cases an USB cable for download is available. You should have at
least some basic computer skills.

Unfortunately, there is no real standard file format, but several ones like epub (almost a
standard), mobi (Kindle from Amazon) and others.

May be you will miss the feeling of a paper book with pages...

A high quality eBook reader is not cheap...

With e.g. a Kindle you are bound to Amazon.

Books and catalogues of art and art exhibitions are not yet available. The quality of the
picture depends  on the data volume that  easily  comes to  a limit.  Moreover  there are
copyrights to be observed.

Not many courses offer an introduction to the creation of an eBook.

Brigitte Hoefer, Barbara Heinze, 20130324
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Tools

Preliminary Notes
In this chapter we want to see, how a draft of a “book” prepared by us, can be converted 
by one or more programs (preferably without any costs) on usually used equipment like 
personal computer, laptop, noteBook, tablet or Mac with the different operating systems in 
such a way, that the “book” can be “presented” and “managed” on suitable devices.

I would like to understand by “book” here, that the new work has the following 
components:

• Title page
• Text with good formatting (adaptable to my reading behaviour)
• Multi-media content (picture, videos, speech)
• Tables
• Lists
• Footnotes
• Cross references (internal in the book and also external)
• Table of contents
• Glossary
• Table of keywords
• Table of pictures

Whether all above mentioned features are possible, we will see later.

For me means “presented”, that the device used can show the text information in such a 
way that I can change the type and the size and the colour of the characters as I want. 
Multi-media contents should be reproduced nearly in the same manner as they have been 
produced.

Usable devices are:
• Personal Computer, Laptops, NoteBooks, with operating systems Windows XP, 

Vista, Windows 7, Windows 8 or Linux (and all derivatives like Ubuntu)
• Mac with operating system OSX 10.6 or later
• eBook Reader like Amazon Kindle Fire, Kindle Fire HD, Kindle DX
• Tablets like iPad, Microsoft Surface RT, Samsung Galaxy Tab, Asus PadFone
• Smart-phones with the operating systems like IOS, Android, Linux 

The “management” of the eBook on the device means that I can set bookmarks and 
annotations which are stored on the device. There should also a presentation of the meta-
data of the book like name of the author, creation date, loading date, language and rights 
(to read, to use, to copy etc.).

General Considerations
Preferably one program shall create from our outline of the coming eBook one electronic 
file, makes it possible to change very easily the font of the text, the size of the text, the 
direction of the text and the colour of the text. Coloured characters, initials, drop-caps, 
slanted fonts, underlining or superposed characters should be possible. There should be 
tables of content, of pictures, of keywords. Also footnotes should be possible (of course on 
the foot of the page). And finally there should be cross references (hyperlinks) from on 
place to an other place within the eBook and to places outside the eBook (e.g. to a picture 
gallery in the internet).
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At this place I must say that nearly all is possible what we can imagine, if we don't worry 
about the necessary effort.

Some restrictions:

A table of content cannot reference to a certain page, only a reference to a certain place is 
possible.

A change of the direction of an inscription (on the left above to the right below) or on a side 
of a picture from above to below is not possible since nearly all eBook-Readers have not 
possibilities to show characters in this way.

Drop-caps (big characters on the start of a paragraph) cannot be handle by the “converter” 
program, since it cannot know how to handle the height of the characters, the spacing of 
the paragraph and the indentation of the text in the paragraph. 

Tables of keywords and tables of pictures require just as big or even bigger effort as tables 
of contents. The creator of the “converter” programs don't have programmed such 
features.

In short words:

The program or the programs for the “converter” of the draft of our “book” to a file which an 
electronic device can handle must fulfil at least the following requirements:

1. The pure text must be included. Bold characters, italic characters and underlined 
characters must be possible.

2. There must be information how to handle the paragraphs, the chapter, the 
headings, tables and lists.

3. There must be at least a table of contents.
4. Footnotes must be presented at the end of the book 
5. Meta-data (like author, creation date, language and information on rights etc.) must 

be contained.
The points 1. and 5. can be handled in separate sub-files. The whole “book” must be in a 
single file with a fixed file extension. In some special cases there must be included some 
access right information. 

At the end of our general considerations and after long searches in the internet and after 
some own trials with the different possible programs I can give the following passable 
recommendation:

Create a draft of your eBook with the program LibreOffice (free
of charge, many languages and for the most platforms). Use
the  special  functions of  the  word processing of  LibreOffice
which can be used also in the eBook as shown in the next
chapter.  Convert  your  draft  with  the  Add-on  to  LibreOffice
called writer2epub.oxt (also free of charge) into a file with the
extension 'epub'. If you want to use the new eBook on a Kindle
device,  you  must  convert  the  epub-file  with  the  additional
program Calibre to a file with the extension 'mobi'.
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Please take into account, that not all version of LibreOffice Writer, writer2epub and Calibre 
can work together without any problems. I recommend (end of April 2013) the versions:

• LibreOffice.exe version 3.6.6.2
• writer2epub.oxt version 1.1.24
• Calibre.exe version 0.9.29

The version 4.0 of LibreOffice shows too may failures in the epub-file!

If you want to read your eBook on a personal computer or a device with the operating 
system Windows, I recommend the following programs for displaying:

• Firefox.exe with the add-on ePubReader version 1.4.2.1 (or higher)
• Calibre Preview
• Sigil.exe version 0.7.2 (or higher)
• Sony Reader for PC version 2.0.02.15180 (or higher)
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Installation of the program LibreOffice and writer2epub.

If you search in the internet for “LibreOffice 3.6.6”, you will see for instance the following 
screen (I searched with firefox.exe and with the search engine “Google”):

I opened the second article “The Document Foundation...” and got the following screen:
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I decided to use the link in the third paragraph “http://libreoffice.org/download/” and got

There I downloaded the main installer and the LibreOffice built-in help:

After finished download of the main installer, I started the installation of the program by 
double click on the LibO_3.6.6._Win_x86_install_multi.msi. 
The next step is to install the LibreOffice built-in help in the same way as the main installer.
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And now you must download the extension writer2epub.oxt in version 1.1.24. You will find 
it as shown in the following picture:

I have chosen the second article “AUR(en) – writer2epub”:

The writer2epub.oxt is a macro extension-file for LibreOffice and can be installed by purely 
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opening with LibreOffice as shown below. I clicked “File” and afterwards “Open” and went 
to the downloaded “writer2epub.oxt”.

Of course you have to click to “OK” to proceed with the installation.

After these installations of LibreOffice.exe, LibreOffice Help and writer2epub.oxt we are 
ready to convert our first “book” to epub-format. I still recommend here in this place 
installing a reading program for epub, in order to facilitate the proofing the conversion.
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Installation of an epub-reading program (ePubReader to Firefox, 
Calibre.exe, Sigil.exe or Sony Reader for PC)

I hope, you have already installed Firefox. Then you search for ePubReader version 
1.4.2.1 as shown below

If you click on the first article, you come to the following installation page.
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You must click only on the bottom “+Add to Firefox”. That's all for the first experiment.
I don't show the installation of Calibre.exe version 0.9.29, Sigil.exe version 0.7.2 and Sony 
Reader for PC version 2.0.02.15180. I hope, you can do it by yourself.

What can be converted with LibreOffice and writer 2epub to epub-
format and what cannot be converted

1. Headings
If you look at the LibreOffice Writer-toolbar, then you will see, that you have a lot of 
possibilities and features to format the text of your draft of the eBook. And you will see also 
some possibilities to insert something to your draft.

If you open the first bottom at the second line, you will get “Styles and Formatting”-feature 
as shown below:

Please take into account, that you have to mark all your headings in the text. Then connect 
them with the item in the “Styles and Formatting”-feature. 
Here, some hints to formatting of headings:

1. Only text, which is formatted as “Heading1” to “Heading10” is included in the index.
2. Heading1 is the main heading and the title of the eBook (if you don't change it 

afterwards)
3. Only Heading1 to Heading3 are indented in the index
4. Heading7 to Heading10 are handled the same way as Heading6
5. Headings in the e-pub-file are always centred
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2. Font and formatting of  characters

If you try to format some characters as shown below

That means, that there is a bigger letter, a bold character, a word in italic characters, some 
underlined characters, an other font (Arial), a text with 90° direction and a word with red 
characters.
After conversion to e-pub-file, you will see the following text on your eBook-reader:

Only the bold and the italic formatting and the underlining are still here!

3. Formatting of paragraphs
A left aligned paragraph, a centred paragraph, a right aligned paragraph and a justified 
paragraph will be shown all in the same way: they are justified and the first line is intended 
1.5 characters. Therefore you should avoid any formatting of whole paragraphs!

4. Insertion of numbered or bulletined lists

If you insert numbered or bulletined lists with the icon: 
you will get for instance the following display in LibreOffice (numbering changed with 
“Format” > “Bullets and Numbering” > “Numbering Type” to 1) ). I inserted also a list with 
bullets.

Page 15 of 32



How to create my own eBook

After conversion to e-pub-format you will get a list with “standard” numbering “1.” and a list 
with “standard” bullets.

5. Insertion of a table
If you want to insert a table you can do it with “Insert” > “Table” and the following input 
instructions:

If you will fill out the table below, make the corrections to all fields (all are text body):

Row 1 Heading Row 2 Heading Row 3 Heading

Content of row 1, line 1 Content of row 2, line 1 Content of row 3, line 1
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then you will get the correct presentation of the table

Please take into account, that you cannot make any corrections to the width or height of 
the fields of the table and that you cannot make corrections to the lines in the table.

6. Insertion of pictures

There exist a special problem with insertion of pictures. My experience is, that you should 
insert pictures with “Insert” > “Picture” > “From File” > choose your picture from the 
windows explorer 

and click on the inserted picture and correct the wrapping to “No Wrap”. Then you will see 
the picture correctly in your ePub-reader respectively in your reading program like “Firefox 
and ePubReader”, “Calibre.exe”, “Sigil.exe” or “Sony Reader for PC”. 
And this is the presentation:
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7. Insertion of Footnotes

If you want to insert a footnote to your eBook, you have to go to “Insert” > 
“Footnote/Endnote” and have to click to “OK” in the following picture

Then you will get a numbered footnote on this place 1. You have to fill out the text of the 
footnote. In ePub-format the footnote will be shown on a separate page of the book.

8. Insertion of Links

How to insert links within the document itself, to outside on the eBook-reader, or to any 
place of the internet:
Choose Insert Hyperlink and click on Internet or document and fill the name field.

Armin Richter, 20130506

1 This is my first footnote in this document
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Guide line to create an eBook

General
Writer2ePub (W2E) is an extension for LibreOffice which allows you to create an ePub file
from any file format that Writer can read. 

This manual is valid for LibreOffice with the ePub converter “writer2epub”.

Writing the Document
 Write the text in the opened LibO-sheet without formating, that means with “default”  

Use a font and font-size convenient to you.

Insertion of Images

It is recommended that the size of images should not exceed 800x600 pixels. 

Writer2epub  ignores  frames,  therefore  images  should  not  be  inserted  in  frames,  i.e.
AutoCaption shall have no ticks (Tools → Options → LibreOffice Writer → AutoCaption →
no  tick  on  LibreOffice  Writer  Picture  (right  hand  menu)).  Otherwise  they  will  be  not
displayed after conversion.

• Click  in  the  LibreOffice  document  where  you  want  the  image  to  appear.  It  is
recommended that it should be inserted after headings or paragraphs. 

• From the menu bar choose Insert → Picture → From File....
• On the Insert Picture dialog box, navigate to the file to be inserted, and select it.
• Click Open.

The caption is treated like a normal text,  that means if  wrapping is not  switch off  the
caption can be anywhere.
(Wrap off: Format → Wrap → Wrap off)
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Step by Step Creation of the eBook
• Indicate title, header, sub header 

•  save the document

• Convert to epub with w2epup  

•  Open the menu preferences  and mark them. According to your intention.

Keep working files
The file which is converted to epub remains open, i.e. you can continue your 
work on the file without awkward reopening.

Close document after conversion
If you do not want to change the file. 

Mobipocket Export (KindleGen required)
Mobipocket is a Software primarily for mobile equiment (smart phones, etc.)
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Warnings
Hide Message
If not ticked warnings will not displayed. But it is more efficient to get them.

Image dimension Limit (kB)
The highest value is 255 kB, but normally the dimensions are higher and if a warning 
comes up during the conversion process, ignore it.

Meta data
Show meta date before conversion.
If ticked you can update them before the conversion starts.

Add W2E credits at the end of the book

It is fair to add the W2E logo  to your eBook because you are using a free of 
charge software. 

Quit with OK.

Open the menu metadata 
 

Fill out the form.

Title: Name of the eBook.
Author: Name/s of person/s who have written the document.
Language: Language in which the eBook is published. With the arrow the language 
menue is opend.
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Publisher: Person/s or institution responsible for the issue.
The boxes title, author and language must have an entry, otherwise the document will not 
be converted.
ID/ISBN: International identification number of the book.
Publishing Date: Date of issue
Original Title: If there is a change, i.e. by translation.
Tags: Keywords
Description: abstract of the document. 
Cover: There are three options 

• First Image: the first image in the document will be used as the eBook cover. 
• No cover
• From file ..: you select a cover image from your file. Use only the formats jpeg, gif, png or 

svg. The images should be not larger than 600x800 pixels.
The selected cover image will be displayed in the shaded box. A red question mark 
remains you if you failed to select an image.
Cover background colour: Click on the colour bar. If another colour is prefered the 
respective colour code has to be given. The e-reader will display this colour behind the 
cover image.

Enter Document Preferences and tick the options. 

Index: Tick the box if you want to have the index page in your eBook.
Index Title: Type in the box the title of your convenience.
File Split: If ticked, each chapter starts on a separate page.

Images
Retain original Images: If ticked, the quality of the original images will not be changed. 
Otherwise it can be reduced in percentage.
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Convert images in Black & White: All images in your eBook are grey. The storage 
volume is consequently reduced.
Widows (Lines): With a widow line begins a paragraph and is abandoned at the bottom of 
a page. The rest of the paragraph is located on the following page. A page should end with 
at least two lines.
Orphans (Lines): An orphan is a single line at the top of a page which finishes a 
paragraph that started on the previous page. Orphan lines can be confusing because they 
cause a disruption in the paragraph. A page should begin with at least two lines.

Fonts: Do not change the default i.e. do not tick “Embed Font in the ePub File”. Not every 
eBook reader will accept this.

Donate: If ticked, you will ask for donation.

Quit with OK. 

Save the document if you have changed it. 

Open the menu “writer2epub” 
Update the meta data menu if necessary and click OK.
Depending on the length of the document and the contents (pictures) the conversion can 
take several minutes. At the end of the conversion process the shown confirmation apears.

Control the markings (scroll down) and click OK
That's it!

If you want to update your document: do it, save the document and repeat the conversion 
(last step).
How to Read the eBook?
You can read your work with any eBook reader who supports the format “epub”. If you 
have created the eBook on a PC or noteBook and you have Mozilla Firefox installed you 
can install the add-on “Epub Reader” 
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(https://addons.mozilla.org/de/firefox/addon/epubreader/)
When you have installed that add-on open Firefox and go to “file opening” navigate to your 
eBook and open it.
If you use the Internet Explorer open it and navigate to the eBook.
You can also install free of charge the e-reader software “Adobe Digital Edition”.

References: http://lukesblog.it/wiki/index.php?title=Usage

Klaus Wessenberg, Norbert Sommer, Klaus Vogt, 20130222
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Appendix:

Description of the epub-file format 

In order to show how an ePub-file is built up, I have prepared a test file with the title 
“Creating an ePub-File with LibreOffice and writer2epub”. I saved it to the disk. The picture 
below shows the text of this test-book within LibreOffice.

With LibreOffice Writer I have created a title page which is shown on the following picture.

Since the title picture of the eBook must have a picture format (.JPG, .BMP) I printed the 
screen with the keys “SHIFT” and “PRTSC/SYSREQ”. Than I imported the screen shot into 
the free program IrfanView, cutted out only the first page and saved it as “Title_en.JPG”.

Then I tried to convert my draft of the test-file with writer2epub within LibreOffice. I used 
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the leftmost sign in the writer2epub-toolbar and had to fill out the meta-data of the e Book 
as shown below.

After that step I clicked OK and after some seconds the writer2epub showed the following 
screen.

This means, that the conversion from the LibreOffice Writer-format .odt to the eBook-
format .epub was successful. 
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Now, what is in the “Creating an e Pub-File with LibreOffice and writer2epub.epub”-
 file? 
We know that the ePub-file is a zipped file. Therefore we will look on it with Winzip.exe 
(unzipping with the free program 7-Zip.exe is also possible).
The epub-file consist of the following sub-files and directories:
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It is easier to look on the e-pub-file with the program Sigil.exe

You will see the following screen

You see that the  text in the different chapters is collected in different files 
“coverpage.xhtml, content001.xhtml to content0006.xhtml, footnote.xhtml, toc.xhtml and 
w2ehtml.xhtml. And that there are some additional files or directories “Styles”, “Images”, 
Fonts”, “Audio”,Videos”,”Misc”, toc.ncx and content.opf.
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If you will look (for instance) at the file content of the file “Content0005.XHTML”, you will 
see the text of chapter five of the test-file in XHTML (a programming language). [I use to 
open a text file with Notepad++.exe and not with Editor.exe]

This file shows you the expected text of chapter five of the test-file. But if you are familiar 
with the HTML or XHTML language, you will also see, that the reference to “sample text” is 
going to the “nirvana” or nowhere. If you want to have a correct linking to sample text, you 
must do a manual correction as shown below.
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The problem of this correction is that you must be familiar with HTML or XHTML-language 
and know what to add or to to omit.

If you open the directory “Styles”, you will find the style sheet file “Style001.css”. You have 
there the possibility to change nearly all things which handle the presentation of the text. 
E.g., if you change in the part “h2” the line “text-align: center;” to “text-align: left;”, than all 
headings with level 2 are shown not centred but left aligned. But be carefully, all changes 
work on all places in your epub. And again the hint, that you must be familiar with the 
handling and writing of style-sheets.
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That's all to the epub-format and for changing your work with the program 
Sigil.exe

Armin Richter, 20130506
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Summary

It was a great experience to step into the world of eBooks - we:
- got information about the details
  and useable electronic devices
- searched for and found eBooks in the internet
  - for charge - mainly new issues
  - and free - often older stuff
  - almost all genres
- found useable and flexible tools
- learned how to produce our own eBooks
- got an insight into the technical issues

Conclusion

The goal to produce an eBook on 'How to create our own eBook' was reached. Several 
lectures and workshops have been realized. The motivation to learn and to be a creator 
was high.

Thank you all very much for your support, inspiration, assistance and finally your articles 
for this document

Alfons Scherr, Manfred Helzle, 20130508

Page 32 of 32


